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Freetown, Sierra Leone
“Heads-up” Digitizing from Scanned Hard-Copy Maps
Part I –Georeferencing Scanned Images 1

Objectives:
•
•
•
•
•
•
•

Explore digital archives of scanned legacy mapping.
Interpret older coordinate systems from map legends.
Learn how to register scanned hard-copy maps to earth coordinate systems
Learn the procedures for capturing tie-points (or ground control points) that relate the
scanned hard-copy map to earth coordinate systems.
Learn standard processes used to transform between local (row and column) and earth
coordinate systems (such as latitude and longitude).
Viewing the space requirements for compressed (with loss) .jpg format files.
Learn the process to permanently georeference scanned maps suitable for use within a
GIS

Data Sources:
Table 1. Sierra Leone Data Sources to be used in this lab.
File
Name
Afr_sl300_1lu

Roads

Rivers

1

Description
Scanned Hard
copy map:
Land Systems
Sierra Leone.
Roads of the
World (Vmap0)
Perennial Water
Courses (VMap0)

Metadata

Format

Scale
Resolution

Coordinate
System

http://eusoils.jrc.it/esdb_archiv
e/EuDASM/africa/lists/csl.htm

.jpg

1:500,000

Local coordinate
system!!

http://www.fao.org/geonetwork
/srv/en/metadata.show?id=128
0&currTab=simple
http://www.fao.org/geonetwork
/srv/en/metadata.show?id=126
9&currTab=simple

ILWIS
Segment

1:1,000,000

GCS_WGS_1984

ILWIS
Segment

1:1,000,000

GCS_WGS_1984

Please quote as:
Kenny F 2006. Heads-up digitizing from scanned hard-copy maps. Manual on data
conversion and data entry (Part I and II), prepared for the FAO project "Land use
planning for optimizing agricultural production” - TCP/SIL/3101a, FAO, Rome.

Background: Data Capture by Scanning
Because the computer allows us to zoom far into images we can work with the mouse and a
scanned image which provides much greater accuracy than is possible than using the more
traditional digitizing tablet. Scanners are much less expensive than digitizers and are much
more accurate. Most people are familiar with scanners, as they can be purchased rather
cheaply in office supply stores. However, the scanners you are most familiar with will
probably only copy legal size paper. For mapping purposes, scanners have to be much larger,
with the ability to accommodate sheet sizes greater than 34”, as shown in Figure 1. These
devices allow a user to digitally scan a map and perform digitizing on the computer screen
(this is called “heads-up” digitizing), thus eliminating the need for a digitizing tablet.

Figure 1. A map scanning system

Processing Steps:
1. In this lab we will first view some scanned Soils maps. If the internet is accessible
from your workstation, go to Joint Research Centre’s Soils Maps of Africa site.
http://eusoils.jrc.it/esdb_archive/EuDASM/africa/index.htm . Spend some time at this
site to be become familiar about what this group does and the soils resources available.
2. In particular explore the Display Maps option and query or browse your way to Sierra
Leone. What you will find here are some 21 scanned hard-copy soils (1951 – 1980)
maps for Sierra Leone. This is a very useful resource, not only does it assist with data
discovery (note and explore the metadata links), but the scanned maps are also
available here to be downloaded utilized. These scanned maps are of a high enough
quality to be utilized directly within GIS automation procedures. For this lab we will
build directly on these efforts by downloading and georeferencing one of these
scanned maps in order to prepare these data for full information extraction in a GIS
system. This is a process know as “Heads-Up” digitizing. We will use the Tie-Point,
Georeferencing and Digitizing modules in ILWIS software for this lab.

3. To save time, I have downloaded the following Map “Land Systems Sierra Leone.
Land Resources and Survey Project SIL/73/002 FAO UNDP-MANR . Here is the
provided Metadata that describes this Map.
Table 2. Map Metadata
Land Systems Sierra Leone. Land Resources and
Title:
Survey Project SIL/73/002 FAO UNDP-MANR.
Birchall, C.J., Bleeker, P.
Author:
1980
Year:
United Nations Development Programme, FAO,
Publisher:
Freetown.
En
Language:
N10°0 - N7°5
Coordinates:
W12°10 - W10°35
500000
Scale:
Land use
Keywords:

Figure 2. Scanned Map to be georeferenced in ILWIS

4. Create a local directory on your workstation and copy across the lab data (see Table 1)
from .../dataforheasupdigitizing/..

5. Start ILWIS (StartÆProgramsÆILWIS 3.3). Once ILWIS opens, navigate to your
local directory where you stored the lab data.
6. From under the File tab, select Import Æ via GDAL. Select our scanned image
afr_sl3000_1lu.jpg and call your Output Filename SLSoils (as below). This is a very
big file give it time to import. GDAL is a GIS Open Source raster data translator. For
more information about GDAL see http://www.gdal.org/ .

7. You may recognize the .jpg extension as a common image extension. This file
contains 7974 pixels by 5887 lines yet only occupies 6.3 MBytes. Jpeg is a
compressed image format and it appears these data are compressed approximately at a
ratio of 20:1. In an uncompressed format these data would occupy approximately 140
Mbytes! This is an appropriate application of the .jpg formats. But because .jpg
format does result in the loss of information and resampling, it is not generally
appropriate for use with calibrated remotely sensed imagery or thematic raster data.
8. You will notice that ILWIS has translated this .jpg into three colour (R/G/B) separates
called SLSoils_band1, SLSoils_band2 and SLSoils_band3 and a R/G/B colour
composite called SLSoils. Double-click on SLSoils and in the following window
from the Toolbar select the Open As ColorComposite option.

Open As ColorComposite.

9. This will bring up the following window, accept the defaults. Select the Create
Pyramid Layers (the practical reason for this will be covered later in the course).
Creating Pyramids is a bit of up-front processing and uses extra disk space but will
save you time in the long-run.

10. This will open your scanned map in a separate Map Window. Take some time to
Roam, Zoom and Pan to explore this Map, the Map Legend and the Map Surround.
You will note at in the bottom right-hand corner of your screen it is indicted this map
has No Coordinates. This is what we are about to change!

11. The next thing we have to do is create a Coordinate System consistent with this Hardcopy map. Through some digging it appears the Coordinate System for this map is as
follows.
Coordinate System:
Spheroid:
Meridian of Origin:
Latitude of Origin:
Datum:

Longitude and Latitude
Clarke 1880 (Modified)
9 West of Greenwich
Equator
Sierra Leone 1960

This information was not found on this particular map. This map does however
reference the base mapping used (Basemap D.O.S. 719/619 Series) and from another
Sierra Leonian map at the JRC website the Spheroid/Datum was as described above.
Sometimes it takes a bit of detective work. The spheroid referenced here is also
consistent with this age of map.

12. Through the next few screens, we will replicate this information for ILWIS to
understand (don’t worry about all the details!). At the main ILWIS window, from
under the File tab select Create Æ Coordinate System... which will initiate the
following window (see below). Enter the Coordinate System Name and Description
as follows. Also select the CoordSystem LatLon option, followed by OK.

13. This will bring you to the following window. Select the Datum button.

14. And from the predefined list select Sierra Leone 1960 (just as our metadata says!).
Now you have a fully created Coordinate System consistent with your scanned hardcopy map. Select OK.

15. Now we will apply this Coordinate System to our map. At your Map Window, from
under the File tab, select Create Æ GeoReference. This will initiate the following
window requiring your input.

16. The GeoReference as we saw in your Raster Lab this morning carries your corner
coordinates, pixel size and has embedded the Coordinate System. As shown above,
call your GeoReference, LandsystemSL. Select the GeoRef Tiepoints option and
beside Coordinate System, click the down-arrow and select our just created
SierraLeone1960 Coordinate System. Also select the Sub-Pixel Precision option.
This will initiate the GeoReference Editor as shown below. The objective here is
through user specified “Tie Points” (or Ground Control Points) to bring this spatially
uncorrected map to a map with earth coordinates. You should be warned before you
begin that this process the first few times through can be quite frustrating!

17. Use the Zoom, Pan and Roam functions to find a location on the map where the
Geographic Coordinates (Longitude and Latitude) can be easily identified. This is a
very good map with many easily identifiable locations. The best locations are along
the map edges or where you see cross-hairs (as above in a red circle) indicating
intersecting Longitude and Latitude values. The intersection shown here is 8deg30sec
North and 13deg West. It is through identifying these points in the lower window we
will be able to completely georeference the entire map. Zoom right into your
identified point, and with the Normal Pointer (as above) click on the identified point.
This will bring-up a new menu for you.

18. This window has identified the local map Row and Column coordinates and you must
enter the Longitude and Latitude for the identified point (as above). To do an accurate
job, you have to zoom quite far into the image to the point you can identify individual
pixels (as below).

19. Continue this process through your image and collect a well distributed pattern of “Tie
Points”. Collect at least 20 point – more is always better. Note the Tie Point table in
the lower half of your screen is like any other table in ILWIS - you can add points,
delete points, etc. Also note in the table the DRow and DCol are estimates per point
of error (measured in pixels) for each selected point.
20. Once you have collected a certain amount of points, in the bottom right-hand corner
your system will start to display earth coordinates. At this point you can even add
vector layers onto your map. Continue to collect points till you have a good
registration of your map. Once satisfied with your registration (or had enough for a
day!), select the Exit Editor button on the tool bar and ILWIS will automatically save
your GeoReference. Before exiting, ensure that you selected a “Full 2nd Order” for
transformation (as in the figure below). This full second order polynomial will best
accommodate any scanning errors introduced or hardcopy map distortions. Once you
leave the editing environment you can not change the order of the polynomial
transformation.

True Longitude and Latitude Coordinates
Vmap(0) Roads Overlain

To Change Transformation (Note you should not require more than Full Second Order)
To exit Editor
Estimate of error (in pixels) in X and Y
Overall Estimate of fit to the selected Polynomial

21. Once you exit the editor, ILWIS will “on-the-fly” calculate earth coordinates for any
location within the image/map. You can actually digitize fully georeferenced segments
or points directly from this map if desired. In our case however we are going to
permanently resample this map to a Geographic Coordinates System (Datum WGS84)
to make this map consistent with our other data sets. Resampling the map will also
enable you to utilize this map within other GIS software.
22. If you want to return to add more tie-points at any time you can reinitiate your editing
session from under the Edit tab Æ GeoReference and continue directly from where
you finished.
23. With at least 20 well distributed tie-points and with an overall registration estimate of
less than one or two pixel, you are ready to RESAMPLE the image/map.
24. From under the Operations tab of Main ILWIS menu, select Image Processing Æ
Resample. This will initiate the following series windows. In the first window (called
Rasample Map) select your input map SLSOILS. Select a BiCubic Resampling
Method (as below) and call your Output Raster Map: soilsgeo (as below). We are not
quite finished with this window yet.
25. We must also create a new GeoReference for our new map – soilsgeo, so select the
create icon beside GeoReference. This will subsequently initiate another window,
(also shown below) that describes a selected Coordinate System (select
LatLongWGS84 from the pull-down menu), Coordinate Extents in Lat and long and
Pixel Size (in degrees, minutes and seconds) of the new map – soilsgeo. Select the
parameters for this window as shown below, followed by OK.
26. Your Resampling is now ready to be conducted. At the Resample Map widow, select
the Show option. This will both resample the map and display the finished results for
you.
27. This is a very intensive computer processing task and it may take some time complete.
Once it has successfully run to completion, examine your fully georeferenced map.

28. What we have accomplished here is the first and required stage for “Heads-Up”
digitizing. The next stage is to actually digitize features on screen and the resultant
segments, points and polygons will have true earth coordinates.
29. Note the next lab - Heads-up Digitizing from Scanned Hard-Copy Maps, Part II
continues directly from this lab utilizing the map soilsgeo that you just created.

